
C
ha

pt
er

 5
Chapter 5 System Diagnostics and 
Troubleshooting

This chapter discusses the tools available for diagnosing and troubleshooting system issues. This 
chapter includes the following sections:

“Help & Support Center (HSC) and E-Support” on page 116

“Troubleshooting Checklist” on page 116

“LED Color Definitions” on page 117

“HP Insight Diagnostics Offline Edition” on page 117

“Troubleshooting Using HP Intelligent Manageability Features” on page 122

“Diagnostic Error Codes” on page 123

“Troubleshooting Scenarios and Solutions” on page 125

“POST and Error Messages” on page 148
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Help & Support Center (HSC) and E-Support
HSC provides online access to technical support information, software updates and downloads, 
diagnostic tools, and HP support contact information.

To open HSC from your desktop, click Start>Help and Support.

HSC contains four sections:

HP Product Information (requires Internet access)—Links to the HP Technical Support Web site for 
your product. You can access all related documentation, downloads and updates, tools, and more.

HP Software & Driver Downloads (requires Internet access)—Links to HP-specific software 
downloads and updates.

HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by HP 
Instant Support Professional Edition.

Contact HP for Support (option available that does not require Internet access)—Provides two 
different options:

Chat with an expert online (requires Internet access)—Provides a tool to communicate with a 
support specialist online through Active Chat.

Call a support agent—Provides hardware details about the workstation and HP support contact 
phone number worldwide.

Troubleshooting Checklist
Before running any of the diagnostic utilities, review the following checklist to find possible solutions for 
workstation or software problems:

Are the workstation and monitor connected to a working electrical outlet?

Is the workstation turned on?

Is the green power light illuminated?

Is the monitor turned on?

Is the green monitor light illuminated?

Turn up the monitor brightness and contrast controls if the monitor is dim.

Press and hold any key. If the system beeps, then the keyboard is operating correctly.

Check all cables for loose or incorrect connections.

Reconfigure the workstation after installing a non-Plug ‘n Play expansion board or other option, such 
as a diskette drive.

Are all of the necessary device drivers installed?

Have all printer drivers been installed for each application?

Remove all diskettes and CDs from the drives before you turn on the system.

Are all switches set correctly?

Are you running the latest BIOS version, drivers, and/or software updates?
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LED Color Definitions
An LED light exists on the front panel of your workstation. The following table describes what each color 
signifies.

HP Insight Diagnostics Offline Edition
The diagnostics utility enables you to perform testing and to view critical computer hardware and 
software configuration information from various sources. This utility allows you to:

Run diagnostics.

View the hardware configuration of the system.

Key Features and Benefits
HP Insight Diagnostics simplifies the process of effectively identifying, diagnosing, and isolating the 
hardware issues.

In addition to robust management tools, service tools can be invaluable in quickly resolving system 
problems. To streamline the service process and resolve problems quickly, it is necessary to have the 
right information available at the time that a service call is placed. The primary information requirement, 
which is also the one that provides the greatest insight into potential system issues, is the configuration 
of the system. Insight Diagnostics helps provide higher system availability. Typical uses of the Insight 
Diagnostics are:

Testing and diagnosing apparent hardware failures

Documenting system configurations for upgrade planning, standardization, inventory tracking, 
disaster recovery, and maintenance

Sending configuration information to another location for more in-depth analysis

Theory of Operation
Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running and 
software information from the system is not available to the diagnostics.

Offline Survey is available to display the current system configuration.

The Insight Diagnostics Test feature provides the capability to test functionality of all the major 
hardware components in the system. The Test feature is designed to be flexible to allow the user to 
customize test selections by providing different modes and types of testing.

A Quick Test provides a predetermined script where a sample of each hardware component is 
exercised and requires no user intervention.

Table 5-1 LED color definitions

LED State LED Color System Status

Solid Green System is on.

Blinking Green System is in Standby.

Solid or Blinking Red System has error. See “Diagnostic Error Codes” on page 123

None No Light System is in Hibernate or it is off.
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A Complete Test provides a predetermined script where each hardware component is fully tested. You 
can select Interactive or Unattended tests. This will change the devices tested during the Complete Test. 
There are more tests available in the interactive mode, but these require user intervention.

A Custom Test provides the most flexibility in controlling the testing of a system. The Custom Test mode 
allows the user to specifically select which devices, tests, and test parameters are run. Users are 
provided the ability to select tests that do not require any user interaction through the Interactive and 
Unattended tests modes.

Diagnostic Utility on CD
HP Insight Diagnostics is available on the Documentation Library CD that was shipped with your 
workstation.

To start the diagnostic utility on the Documentation Library CD:

1 Turn on your workstation and press the F10 key during the initial boot process to enter the Computer 
Setup (F10) Utility (page 36).

2 Select your language from the list and press the Enter key. In the Computer Setup Utilities menu, 
there are five headings displayed: File, Storage, Security, Power, and Advanced.

3 Use the right arrow key to select Storage. Use the down arrow key to select Boot Order, then press 
Enter.

4 Select CD-ROM Drive and enable it as a bootable device by pressing the F5 key (if not already 
enabled, pressing F5 key again disables the device).

5 Set the CD-ROM Drive to the top of the boot order. To do this, select CD-ROM, press Enter, and use 
use the up arrow to move it to top of order.

6 To apply and save changes, press the F10 key, then select File>Save Changes and Exit.

7 Insert the Documentation Library CD into the workstation.

8 Restart your system and HP Insight Diagnostics launches automatically.

Download the ISO Image
The download the latest diagnostic utility.

1 Visit http://www.hp.com.

2 Click the Support & Drivers link.

3 Click the Download driver and software radio button.

4 Enter your product number (for example, xw4200) in the text box and press Enter.

5 Select your OS.

6 Click the Diagnostic link.

7 Locate HP Insight Diagnostics and click Download.
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User Interface

NAVIGATION

The Insight Diagnostics home page contains the following tabs: Survey, Test, Status, Log, and Help. 
These tabs separate the major functions of Insight Diagnostics.

SURVEY TAB

When the Survey tab is selected, the Survey menu displays and allows you to view important system 
configuration information. The Summary view limits the amount of data displayed, while the Advanced 
view shows all the data in the selected category. Regardless of whether you choose Advanced or 
Summary, the following categories of information are available on the Survey menu:

Overview—The Overview view gives you a listing of general information about the computer.

All—The All view gives a listing of all information about the computer.

Architecture—The Architecture view shows the type of bus the computer uses. In addition, if the bus 
is PCI, information about the PCI configuration is displayed.

Asset Control—The Asset Control view shows the serial number of the computer (system 
identification number).

Communication—The Communication view shows information about the computer parallel (LPT) 
and serial (COM) port settings, USB, and network controller information.

Graphics—The Graphics view shows information about the graphics subsystem of the computer. 
This includes information about the graphics card, mode, and ROM.

Input Devices—The Input Devices view shows information about the type of keyboard, mouse, and 
other input devices connected to the computer.

Internal Conditions—The Internal Conditions view shows information about the health of the 
computer. This includes fan, temperature, and power supply information.

Memory—The Memory view shows information about all memory in the computer. This includes 
memory on the board and any memory modules installed.

Miscellaneous—The Miscellaneous view shows information obtained from the computers 
configuration memory (CMOS), BIOS data area, Interrupt Vector table, and diagnostics component 
information.

Multimedia—The Multimedia view shows information about all multimedia devices in the 
workstation. This includes audio devices installed.

Resources—The Resources view shows the system device resource usage information. This 
includes information about I/O, memory, IRQ, slot, and bus usage.

Storage—The Storage view shows information about storage media connected to the computer. This 
list includes all fixed disks, diskette drives, and CD-ROM drives.

System—The System view shows product type, processor type and speed, and coprocessor 
information. Also shown in this display is information about all ROMs in the computer.
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TEST TAB

The Insight Diagnostics utility provides the capability to test all the major pieces of hardware in the 
system. You can select from several types of tests:

Quick Test—Provides a predetermined script where a sample of each hardware component is 
exercised and requires no user intervention.

Complete Test—Provides a predetermined script where each hardware component is fully tested. 
You can select Interactive or Unattended tests. This will change the devices tested during the 
Complete Test. There are more tests available in the interactive mode, but these require user 
intervention.

Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test 
mode enables the user to specifically select which devices, tests, and test parameters are run. Users 
are provided the ability to select tests that do not require any user interaction through the Interactive 
and Unattended test modes.

To begin testing:

1 Select the Test tab.

2 Select the Type of Test to perform and then select the Test Mode, either Interactive or Unattended. 

3 Choose how you want the test to be executed, either Number of Loops or Total Test Time.

When choosing to run the test over a specified number of loops, enter the number of loops to 
perform. If you desire to have the diagnostic test for a specified time period, enter the amount of 
time in minutes.

NOTE Testing will automatically stop, if one test loop has been completed, when the elapsed test time 
has reached the specified time limit.

4 Click Begin Testing to start the test.

While tests are being performed, the user can monitor the progress by viewing the Status tab. Any 
errors that are detected are summarized in the Error Log. Click the Print button to print or save the 
report.

If the diagnostics utility detects an error during a test, the user can mouse-over the failed text in the 
Status tab to display additional information for the type of error and the error code.

To view all test failure information, select the Error Log. To view the status of all testing that has 
been performed, select the Log tab.
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STATUS TAB

The Status tab displays the status of the selected tests. The type of test executed (for example, Quick, 
Complete, Custom) is displayed. The main progress bar displays the percent complete of the current 
set of tests. While testing is in progress a Cancel testing button, which will cancel the test job, is 
displayed.

After testing has completed the Cancel testing button is replaced with two buttons, Select New Tests 
and Retest. The Select New Tests button allows you to go back to the previous test selection page to 
select a new set of tests. The Retest button will retest the last set of tests executed. This enables you to 
re-run the set of tests without having to go back to the test selection page.

The Status page also shows:

The devices being tested.

The tests that are running.

The overall elapsed time.

The individual elapsed test times.

The condition status of each test.

LOG TAB

The Log tab consists of three views.

Test Log—Displays all tests that have been executed, number of times of execution, number of 
times the test failed, and the time it took to complete the test. The Clear Test Log button will clear the 
contents of the Test Log.

Error Log—Displays the tests that have failed during the diagnostic testing. Besides displaying the 
device and test this section might also include error details. The description section describes the 
error that the diagnostic test found. The Recommended Repair will give a recommended action that 
should be performed to resolve the failed hardware. The error count is the number of times the test 
has failed. The Clear Error Log button will clear the contents of the Error Log.

Test Components—Hardware and software tests can be performed on the following components:

Audio—Identifies all audio devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

CPU—Identifies all processors installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

Inspect—Captures general system configuration information.

Keyboard—Identifies the keyboard installed in a system and provides the ability to verify proper 
operation of this device.

Memory—Identifies all memory modules installed in a system, captures any associated 
configuration information, and provides the ability to verify proper operation of these modules.

Modem—Identifies all modem devices installed in a system, captures any associated 
configuration information, and provides the ability to verify the proper operation of these devices.

Mouse—Identifies the mouse installed in a system and provides the ability to verify proper 
operation of this device.
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Network—Identifies all network devices installed in a system, captures any associated 
configuration information, and provides the ability to verify proper operation of these devices. NIC 
testing is only performed if drivers are installed during discovery.

Parallel Port—Identifies all parallel devices installed in a system and captures any associated 
configuration information. If the parallel port is properly configured and the information is available 
to the operating system, the associated DMA, IRQ, and I/O ports are reported. This test 
component also provides the ability to verify proper operation of these devices.

PCI Bus—Identifies all PCI devices installed in a system and provides the ability to verify proper 
PCI I/O operation to the devices.

Serial Port—Identifies all serial devices installed in a system, captures any associated 
configuration information, and provides the ability to verify proper operation of these devices.

Storage—Identifies storage devices connected to a system through IDE, USB, SCSI or a Fibre 
Channel network. Supported devices include:

IDE hard disk drives

USB diskette drives

SCSI disk drives

SCSI tape drives

SCSI controllers

RAID controllers

Controllers can be connected to the host through PCI, I2C, or serial port. The component also 
captures any associated configuration information, and provides the ability to verify proper 
operation of these devices.

Stress—Provides a solution for stress testing hardware in a system.

USB—Identifies all USB devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

Graphics—Identifies all graphic devices installed in a system, captures any associated 
configuration information, such as the ASIC and monitor types, and provides the ability to verify 
proper operation of these devices.

A list of available tests for each test component and a list of error codes can be accessed through the 
Test Component and Error Codes menu selections on the Help tab menu bar.

Troubleshooting Using HP Intelligent Manageability 
Features

The Local Alert Pop-Up Dialog notifies you of an impending or actual hardware failure. If the workstation 
is connect to a network and the HP Insight Management Agents are installed and configured, a Simple 
Network Management Protocol (SNMP) trap (message) is sent to the specified SNMP-compliant 
management application.
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Diagnostic Error Codes
This section gives an overview of the diagnostic lights and error codes that are related to the HP 
Workstation xw4200.

Diagnostic Light Codes

Table 5-2 Diagnostic Light Codes

Chassis Indicator Lights

Power LED and Sound 
Activity

Diagnosis and Service Action

None System does not power on
Press power button. If HDD LED = GREEN, then:

1 Verify voltage selected.

2 Remove expansion cards one at a time until the 5V_Aux light on the system board 
illuminates.

3 Replace system board.

OR

1 Press power button. If HDD LED does not illuminate, then:

2 Verify workstation plugged into live AC outlet.

3 Verify power button harness connected to system board.

4 Verify that both power supply cables are properly connected to the system board.

5 Verify that the 5V_Aux light on the system board is illuminated. If on, replace the 
power button harness.

6 Disconnect the AC power cord. Disconnect all internal power supply cables. Plug 
in the AC power cord. On the rear panel of the workstation, look through the 
ventilation holes above the power cord connector for a green LED light.

If the green LED light is not visible or the power supply fan is not spinning, 
replace the power supply.

If the green LED light is visible and the power supply fan is spinning, the 
power supply is functional.

7 Replace system board.

Solid GREEN Power LED Workstation on. No action required.

GREEN Power LED flashes 1 
time every 2 seconds

Workstation in Suspended to RAM mode (select models) or normal Suspend or 
Standby mode. No action required.

Blinks RED 2 times, once per 
second, then 2 second pause, 
2 beeps

Thermal Shutdown:

1 Ensure the workstation air vents are not blocked and cooling fan is running.

2 Open hood, press power button, and see if processor fan spins. If not spinning, 
ensure fan cable is plugged into the system board. Ensure fan is fully/properly 
seated.

3 If fan is plugged in and seated but not spinning, then replace processor fan.

4 Reseat CPU heatsink and verify fan assembly properly attached.
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Blinks RED 3 times, once per 
second, then 2-second pause, 
3 beeps

CPU not installed:

1 Install CPU.

2 Reseat CPU.

Blinks RED 4 times, once per 
second, then 2 second pause, 
4 beeps

Power supply failure:

1 Open the access panel and ensure the 4-wire power supply cable is properly 
connected to the system board.

2 Locate faulty device by removing all devices and then reinstalling one at a time 
until workstation fails. Replace the device causing the failure. Continue adding 
devices to ensure all are functioning properly.

3 Replace the power supply.

4 Replace the system board.

Blinks RED 5 times, once per 
second, then 2 second pause, 
5 beeps

Pre-video memory error.

1 Reseat memory modules.

2 Replace memory modules one at a time to find the faulty module.

3 Replace third-party modules with HP memory.

4 Replace system board.

Blinks RED 6 times, once per 
second, then 2 second pause, 
6 beeps

Pre-video graphics card error.
For systems with integrated graphics, replace system board.
For systems with graphic cards, 

1 Reseat the graphics card. Power on the system.

2 Replace the graphics card.

3 Replace the system board. 

Blinks RED 7 times, once per 
second, then 2 second pause, 
7 beeps.

System board failure (ROM detected failure before video).
Replace system board.

Blinks RED 8 times, once per 
second, then 2 second pause, 
8 beeps

Invalid ROM based on bad checksum.

1 Reflash ROM.

2 Replace system board.

Blinks RED 9 times, once per 
second, then 2 second pause, 
9 beeps

System powers on but is unable to boot.

1 Replace the system board.

2 Replace the processor.

Blinks RED 10 times, once per 
second, then 2 second pause, 
10 beeps

Bad option card.

1 Check each graphics card by removing the card (one at a time if multiple cards), 
then power on the system to see if the fault goes away.

2 Once a bad card is identified, remove and replace the bad option card.

3 Replace the system board.

Table 5-2 Diagnostic Light Codes (Continued)

Chassis Indicator Lights (Continued)

Power LED and Sound 
Activity

Diagnosis and Service Action
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Troubleshooting Scenarios and Solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible 
solutions for each. Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if 
the power supply still works.

To test the power supply:

1 Disconnect all internal power supply cables.

2 On the rear panel of the workstation, look through the ventilation holes above the power cord 
connector for a green LED light. If the light is visible, the power supply is functional.

Solving Minor Problems

Table 5-3 Solving Minor Problems

Problem Cause Possible Solution

Workstation appears locked up 
and will not turn off when the 
power button is pressed.

Software control of the power 
switch is not functional.

1 Press and hold the power button for at least 
four seconds until the workstation turns off.

2 Disconnect electrical plug from outlet.

Workstation will not respond to 
USB keyboard or mouse.

Workstation is in standby mode. Press the power button to resume from standby 
mode.

NOTE: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Workstation date and time 
display is incorrect.

Real-time clock (RTC) battery 
may need to be replaced. 

1 Reset the date and time under Control Panel. 

2 Replace the RTC battery.

Workstation appears to pause 
periodically.

Network driver is loaded and no 
network connection is 
established.

Establish a network connection, or use Computer 
Setup or Microsoft Windows Device Manager to 
disable the network controller.

Cursor will not move using the 
arrow keys on the keypad.

The Num Lock key might be on. Press the Num Lock key. The Num Lock key can 
be disabled (or enabled) in Computer Setup.

Cannot remove access panel. Solenoid hood lock, featured on 
some workstations, is locked.

1 Unlock the solenoid hood lock using 
Computer Setup.

2 Use the access panel FailSafe Key in case of 
forgotten password, power loss, or 
workstation malfunction.

Poor performance is 
experienced.

Processor is hot. 1 Ensure airflow to the workstation is not 
blocked.

2 Ensure the fans are connected and working 
properly (some fans only operate when 
needed).

3 Ensure the processor heatsink is installed 
properly.

Hard drive is full. Transfer data from the hard drive to create more 
space on the hard drive.
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Workstation powered off 
automatically and the Power 
LED flashes Red two times, 
once every second, followed 
by a two-second pause.

Processor thermal protection 
activated:
A fan might be blocked or not 
turning.
OR 
The heatsink is not properly 
attached to the processor.

1 Ensure workstation air vents are not blocked 
and the cooling fan is running.

2 Open hood, press power button, and see if the 
processor fan spins. If not spinning, be sure 
the fan’s cable is plugged onto the system 
board header. Ensure the fan is fully/properly 
seated or installed.

3 Replace the processor fan.

4 Reseat processor heatsink and verify that the 
fan assembly is properly attached.

System does not power on and 
the LEDs on the front of the 
workstation are not flashing.

System unable to power on. Press and hold the power button for less than 4 
seconds. If the hard drive LED turns green, then:

1 Remove the expansion cards one at a time 
until the 5V_aux light on the system board 
turns on.

2 Replace the system board.

OR

Press and hold the power button for less than 4 
seconds. If the hard drive LED does not turn on 
green then:

1 Check that the unit is plugged into a working 
AC outlet.

2 Open hood and check that the power button 
harness is properly connected to the system 
board.

3 Check that both power supply cables are 
properly connected to the system board.

4 If the 5V_aux light on the system board is on, 
then replace the power button harness.

5 If the 5V_aux light on the system board is off, 
perform the Built-In Self-Test on the power 
supply. Disconnect the AC power cord from 
the system. Disconnect all internal power 
supply cables. Plug in AC power.

If the green BIST LED on the rear of the 
workstation is lit AND the fan is spinning, 
the power supply is functional.

If the green BIST LED is not lit OR the fan is 
not spinning, replace the power supply.

6 Replace the system board.

Table 5-3 Solving Minor Problems (Continued)

Problem Cause Possible Solution
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Solving Power Supply Problems
Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply 
still works.

To test the power supply:

1 Disconnect the AC power cord from the workstation.

2 Disconnect all internal power supply cables.

3 Plug in the AC power cord.

If the green BIST LED 1 on the rear of the workstation is lit AND the fan is spinning, the power 
supply is functional.

If the green BIST LED is not lit OR the fan is not spinning, replace the power supply.

Table 5-4 Solving Power Supply Problems

Problem Cause Solution

Power supply shuts down 
intermittently.

Power supply fault. Replace the power supply.

Workstation powered off 
automatically and the Power LED 
flashes Red two times, once every 
second, followed by a two-second 
pause.

Processor thermal protection 
activated:

A fan might be blocked or not 
turning.

OR 

The heatsink/fan assembly is 
not properly attached to the 
processor.

1 Ensure that the workstation air vents are not 
blocked and the cooling fan is running.

2 Open hood, press the power button, and see 
if the processor fan spins. If the processor 
fan is not spinning, make sure the fan’s 
cable is plugged onto the system board 
header. Ensure the fan is fully/properly 
seated or installed.

3 Replace the processor fan.

4 Reseat processor heatsink and verify that 
the fan assembly is properly attached.

1
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Power LED flashes Red, once 
every two seconds.

Power failure (power supply is 
overloaded).

1 Open the hood and ensure the 4-wire power 
supply cable is seated into the connector on 
the system board.

2 Check if a device is causing the problem by 
removing ALL attached devices). Power on 
the system. If the system enters the POST, 
then power off and replace one device at a 
time and repeat this procedure until failure 
occurs. Replace the device causing the 
failure. Continue adding devices one at a 
time to ensure all devices are functioning 
properly.

3 Perform BIST on power supply. If power 
supply fan does NOT spin or the green BIST 
LED does NOT light, replace the power 
supply.

4 Replace system board.

Table 5-4 Solving Power Supply Problems (Continued)

Problem Cause Solution
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Solving Diskette Problems

Table 5-5 Solving Diskette Problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows 2000 and Microsoft 
Windows XP, right-click Start, click Explore, 
and select a drive. Select 
File>Properties>Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Drive button is not pushed in. Push in drive button.

Files on diskette are damaged. Check the program diskettes.

Drive cable is not properly 
connected.

Reconnect power cable. Ensure that all four 
pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and power cables.

Removable drive is not seated 
properly.

Reseat the drive.

Diskette drive cannot write to a 
diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-protected. Use another diskette or remove the write 
protection.

Writing to the wrong drive. Check the drive letter in the path statement.

Not enough space is left on the 
diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check the storage 
security feature disabled settings.

Diskette is damaged. Replace the damaged disk.
TROUBLESHOOTING SCENARIOS AND SOLUTIONS 129



Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, you might 
need to specify diskette capacity. For example, 
to format a 1.44-MB diskette, enter the 
following command at the MS-DOS prompt:
FORMAT A: /F:1440

A problem has occurred with a disk 
transaction.

The directory structure is bad, 
or there is a problem with a file.

In Windows 2000 and Windows XP, right-click 
Start, click Explore, and select a drive. Select 
File>Properties>Tools. Under Error-checking, 
click Check Now.

Diskette drive cannot read 
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong 
diskette type for the drive type.

Check the type of drive that you are using and 
use the correct diskette type.

You are reading the wrong 
drive.

Check the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” message is 
displayed.

A diskette that does not contain 
the system files needed to start 
the workstation has been 
inserted in the drive.

When drive activity stops, remove the diskette 
and press the Spacebar. The workstation 
should start up.

Diskette error has occurred. Restart the workstation by pressing the power 
button.

Cannot boot to diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer Setup.

Run Computer Setup and enable diskette boot 
in Storage>Boot Order.

Removable media boot has 
been disabled in Computer 
Setup.

Run Computer Setup and enable Removable 
Media Boot in Storage>Storage Options.

Diskette MBR validation is 
enabled.

Run Computer Setup and disable Diskette 
MBR Validation in Storage>Storage 
Options.

Table 5-5 Solving Diskette Problems (Continued)

Problem Cause Solution
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Solving Hard Drive Problems

Table 5-6 Solving Hard Drive Problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad sectors or 
has failed.

Use a utility to locate and block usage of bad 
sectors. If necessary, reformat the hard disk.

Disk transaction problem. Either the directory structure is 
bad or there is a problem with 
a file.

In Windows 2000 and Windows XP, right-click 
Start, click Explore, and select a drive. Select 
File>Properties>Tools. Under Error-checking, 
click Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system might not have 
automatically recognized a 
newly installed device.

1 Run Computer Setup.

2 If the system still does not recognize the new 
device, check to see if the device is listed 
within Computer Setup. If it is listed, 
the probable cause is a driver problem. If it is 
not listed, the probable cause is a hardware 
problem.

3 If this is a newly installed drive, enter Setup 
and try adding a POST delay under 
Advanced>Power-On.

Drive jumper settings might be 
incorrect.

If the drive is a secondary drive that has just 
been installed on the same cable as the primary 
drive, verify that the jumpers for both drives are 
set correctly.

Drive’s IDE (ATA) controller is 
disabled in Computer Setup.

Run Computer Setup and enable the IDE 
controller in Storage>Storage Options.

Drive responds slowly 
immediately after power-up.

Run Computer Setup and increase the POST 
Delay in Advanced>Power-On Options.

Nonsystem disk/NTLDR missing 
message.

System is trying to start from a 
non-bootable diskette.

Remove the diskette from the diskette drive.

System is trying to start from a 
damaged hard drive.

1 Insert a bootable diskette into the diskette 
drive and restart the workstation.

2 If the hard drive is still inaccessible and MBR 
Security is enabled, try restoring the 
previously saved MBR image by entering 
Setup and selecting Security>Restore 
Master Boot Record.

System files missing or not 
properly installed.

1 Insert a bootable system diskette and 
restart.

2 Verify hard drive is partitioned and 
formatted.

3 Install system files for the appropriate 
operating system if necessary.

Hard drive boot disabled in 
Computer Setup.

Run Computer Setup and enable the hard drive 
entry in the Storage>Boot Order list.

Second UATA hard drive does not 
perform optimally.

Using the wrong cable for the 
drive type.

Reinstall the second UATA hard drive using an 
80-conductor cable (standard on select models).
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Solving Display Problems

Workstation will not start. Hard drive is damaged. Observe the beeps and LED lights on the front of 
the workstation. See the “POST and Error 
Messages” on page 148.

Workstation seems to be locked 
up.

Program in use has stopped 
responding to commands.

1 Attempt the normal Windows “Shut Down” 
procedure.

2 Press the power button for four or more 
seconds to turn off the power.

3 Restart the workstation using the power 
button.

Table 5-7 Solving Display Problems

Problem Cause Solution

Blank screen (no video). The cable connections are not 
correct.

Check the cable connections from the monitor to 
the workstation and to the electrical outlet.

Screen blanking utility installed 
or energy saver features 
enabled.

Press any key or click the mouse button and, if 
set, enter your password.

System ROM is bad; system is 
running in FailSafe Boot Block 
mode (indicated by eight 
beeps).

Reflash the ROM using a ROMPaq diskette.

Fixed-sync monitor will not 
sync at the resolution chosen.

Ensure that the monitor can accept the same 
horizontal scan rate as the resolution chosen.

Computer is in standby mode. Press the power button to resume from standby 
mode.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Monitor cable plugged into the 
wrong connector.

If the workstation system has both an integrated 
graphics connector and an PCI expansion card 
connector, plug the monitor cable into the PCI 
expansion card connector.

Monitor settings in the 
workstation are not compatible 
with the monitor.

1 Restart the workstation and press F8 during 
startup when you see “Press F8” in the 
bottom right corner of the screen.

2 Using the keyboard arrow keys, select 
Enable VGA Mode and press Enter.

3 In Windows Control Panel, double-click the 
Display icon and select the Settings tab.

4 Use the sliding control to reset the 
resolution.

Table 5-6 Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Power LED flashes Red six times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps six times.

Pre-video graphics error. For systems with a graphics card:

1 Reseat the graphics card.

2 Replace the graphics card.

3 Replace the system board.

4 For systems with integrated graphics, 
replace the system board.

Monitor does not function properly 
when used with energy saver 
features.

Monitor without energy saver 
capabilities is being used with 
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters. The brightness and contrast 
controls are not set properly.

Adjust the monitor brightness and contrast 
controls.

Cables are not properly 
connected.

Check that the graphics cable is securely 
connected to the graphics card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics controller was 
upgraded, the correct video 
drivers might not be loaded.

Install the video drivers included in the upgrade 
kit.

Monitor is not capable of 
displaying requested 
resolution.

Change requested resolution.

The picture is broken up, rolls, 
jitters, or flashes.

The monitor connections might 
be incomplete or the monitor 
might be incorrectly adjusted.

1 Be sure the monitor cable is securely 
connected to the workstation.

2 In a two-monitor system or if another monitor 
is in close proximity, be sure the monitors 
are not interfering with each other’s 
electromagnetic field by moving them apart.

3 Fluorescent lights or fans might be too close 
to the monitor.

Monitor must be degaussed. Degauss the monitor. 

Vibrating or rattling noise coming 
from inside a CRT monitor when 
powered on.

Monitor degaussing coil has 
been activated.

None. It is normal for the degaussing coil to be 
activated when the monitor is powered on.

Clicking noise coming from inside a 
CRT monitor.

Electronic relays have been 
activated inside the monitor.

None. It is normal for some monitors to make a 
clicking noise when turned on and off, when 
going in and out of standby mode, and when 
changing resolutions.

High pitched noise coming from 
inside a flat panel monitor.

Brightness and/or contrast 
settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, 
or shadowing effects; horizontal 
scrolling lines; faint vertical bars; or 
unable to center the picture on the 
screen. (Flat panel monitors using 
an analog VGA input connection 
only.)

Flat panel monitor’s internal 
digital conversion circuits 
might be unable to correctly 
interpret the output 
synchronization of the graphics 
card.

1 Select the monitor’s Auto-Adjustment option 
in the monitor’s on-screen display menu.

2 Manually synchronize the Clock and Clock 
Phase on-screen display functions. 
Download SoftPaq SP20930 or SP22333, 
depending on the monitor, to assist with the 
synchronization.

Table 5-7 Solving Display Problems (Continued)

Problem Cause Solution
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Certain typed symbols do not 
appear correct.

The font you are using does 
not support that particular 
symbol.

Use the Character Map to locate the and select 
the appropriate symbol. Click Start>All 
Programs>Accessories>System 
Tools>Character Map. You can copy the 
symbol from the Character Map into a document.

Table 5-7 Solving Display Problems (Continued)

Problem Cause Solution
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Solving Audio Problems

Table 5-8 Solving Audio Problems

Problem Cause Solution

Sound does not come out of the 
speaker or headphones.

Software volume control is 
turned down.

Double-click the Speaker icon on the taskbar and 
use the volume slider to adjust the volume.

The external speakers are not 
turned on.

Turn on the external speakers.

External speakers plugged into 
the wrong audio jack.

Refer to the sound card documentation for 
proper speaker connection.

Audio cable not connected. Connect audio cable between CD or DVD-ROM 
drive and the system board.

Digital CD audio is 
not enabled.

Enable digital CD audio:

1 From the Control Panel, select System.

2 On the Hardware tab, click the Device 
Manager button.

3 Right-click on the CD/DVD device and select 
Properties.

4 On the Properties tab, be sure “Enable 
digital CD audio for this CD-ROM device” is 
checked.

Headphones or devices 
connected to the line-out 
connector mute the internal 
speaker.

Turn on and use headphones or external 
speakers, if connected, or disconnect 
headphones or external speakers.

Volume is muted. 1 From the Control Panel program, click 
Sound, Speech and Audio Devices, then 
click Sounds and Audio Devices.

2 Click the Mute checkbox to remove the 
check mark from the box.

Computer is in standby mode. Press the power button to resume from standby 
mode.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Noise or no sound comes out of 
the speakers or headphones.

1 If using digital speakers that have a stereo 
jack and want the system to auto-switch to 
digital, use a stereo-to-mono adapter 
to properly engage the auto-sense feature 
or use the multimedia device properties 
to manually switch the audio signal from 
analog to digital.

2 If the headphones have a mono jack, use 
the multimedia device properties to switch 
the system to analog out.

NOTE: If you set digital as the Output Mode, the internal speaker and external analog speakers will no longer output 
audio until you switch back to an auto-sense or analog mode.

If you set analog as the Output Mode, external digital speakers will not function until you change the output mode back 
to an auto-sense or digital mode.
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Solving Printer Problems

Sound cuts in and out. Processor resources are being 
used by other open 
applications.

Shut down all open processor-intensive 
applications.

Workstation appears to be locked 
up while recording audio.

The hard disk may be full. 1 Before recording, be sure there is enough 
free space on the hard disk.

2 Try recording the audio file in a compressed 
format.

Table 5-9 Solving Printer Problems

Problem Cause Solution

Printer will not print. Printer is not turned on and 
online.

Turn the printer on and be sure it is online.

The correct printer driver for 
the application are not 
installed.

1 Install the correct printer driver for the 
application.

2 Try printing using the MS-DOS command:
DIR C:\>[printer port]
where [printer port] is the address of the 
printer being used. If the printer works, 
reload the printer driver.

If you are on a network, you 
might not have made the 
connection to the printer.

Make the proper network connections to the 
printer.

Printer might have failed. Run printer self-test.

Printer will not turn on. The cables might not be 
connected properly.

Reconnect all cables.

Printer prints garbled information. The correct printer driver is not 
installed.

Install the correct printer driver for the 
application.

The cables might not be 
connected properly.

Reconnect all cables.

Printer memory might be 
overloaded.

Reset the printer by turning it off for one minute, 
then turn it back on.

Printer is offline. The printer might be out of 
paper.

1 Check the paper tray and refill it if it is empty. 

2 Select online.

Table 5-8 Solving Audio Problems (Continued)

Problem Cause Solution
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Solving Keyboard and Mouse Problems

Table 5-10 Solving Keyboard Problems

Problem Cause Solution

Keyboard commands and typing 
are not recognized by the 
workstation.

Keyboard connector is not 
properly connected.

1 Turn off the workstation.

2 Reconnect the keyboard to the back of the 
workstation and restart the workstation.

Program in use has stopped 
responding to commands.

Shut down the workstation using the mouse and 
then restart the workstation.

Keyboard needs repairs. Replace the keyboard.

Workstation is in standby 
mode.

Press the power button to resume from standby 
mode.

NOTE: Some mouse software applications might 
interfere with the functionality of the keyboard 
and mouse if the keyboard and mouse are 
connected to your workstation through a 
keyboard, video, mouse (KVM) switch. If you are 
experiencing “no-response” from your keyboard 
and mouse, you might need to uninstall the 
mouse software or connect the keyboard and 
mouse directly to the keyboard and mouse 
connectors on the workstation.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Cursor will not move using the 
arrow keys on the keypad.

The Num Lock key might be 
on.

Press the Num Lock key. The Num Lock light 
should not be on if you want to use the arrow 
keys. The Num Lock key can be disabled 
(or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged into the 
back of the workstation.

1 Shut down the workstation using the 
keyboard.

2 Plug the mouse connector into the back of 
the workstation (or the keyboard) and restart 
the workstation.

Program in use has stopped 
responding to commands.

Shut down the workstation using the keyboard 
and then restart the workstation.

Mouse needs repairs. Replace the mouse.

Workstation is in standby 
mode.

Press the power button to resume from standby 
mode.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Mouse will only move vertically or 
horizontally, or movement is jerky.

Mouse roller ball is dirty. Remove roller ball cover from the bottom of the 
mouse and clean it.
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Solving Front Panel Component Problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device in 
the corresponding port on the back side of the computer. If this does not fix the problem, or you must use 
the front panel ports, continue troubleshooting.

Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.

Table 5-11 Solving Front Panel Component Problems

Problem Cause Solution

If a USB device, headphone, or 
microphone is not recognized by 
the workstation.

It is not properly connected. 1 Turn off the workstation.

2 Reconnect the device to the front of the 
workstation and restart the workstation.

The device does not have 
power.

If the USB device requires AC power, be sure 
one end is connected to the device and one end 
is connected to a live outlet.

The correct device driver is not 
installed.

1 Install the correct driver for the device.

2 You might need to reboot the workstation.

The cable from the device to 
the computer does not work.

1 If possible, replace the cable.

2 Restart the workstation.

The device is not working. 1 Replace the device.

2 Restart the workstation.

A device in the IEEE-1394 port is 
not responsive.

Cable(s) of new external 
device are loose or power 
cables are unplugged.

Ensure that all cables are properly and securely 
connected.

The power switch on the 
device is not turned on. 

Turn off the workstation, turn on the external 
device, then turn on the workstation to integrate 
the device with the workstation system.

The IEEE-1394 port is not active. The port is not there because it 
was not purchased with the 
system. 

You can buy an IEEE1394 connection. Contact 
an HP seller. 

The IEEE-1394 cable might 
not be connected to the IEEE-
1394 card.

1 Turn off the workstation.

2 Remove the access panel. See “Access 
Panel” on page 77 for more information.

3 Be sure to connect the front IEEE-1394 pre-
installed cable to the IEEE-1394 card. See 
“IEEE-1394 (Optional)” on page 82.
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Solving Hardware Installation Problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional 
diskette drive. If you install a Plug ‘n Play device, Windows 2000 and Windows XP automatically 
recognize the device and configure the workstation. If you install a non-Plug ‘n Play device, you must 
reconfigure the workstation after completing installation of the new hardware. In Windows 2000, select 
the Add New Hardware icon in the Control Panel (for Windows XP, use the Add Hardware Wizard) and 
follow the instructions that appear on the screen.

Table 5-12 Solving Hardware Installation Problems

Problem Cause Solution

A new device is not recognized as 
part of the system.

Device is not seated or 
connected properly.

Ensure that the device is properly and securely 
connected and that pins in the connector are not 
bent down.

Cables of new external device 
are loose or power cables are 
unplugged.

Ensure that all cables are properly and securely 
connected and that pins in the cable or 
connector are not bent down.

Power switch of new external 
device is not turned on.

Turn off the workstation, turn on the external 
device, then turn on the workstation to integrate 
the device with the workstation system.

When the system advised you 
of changes to the 
configuration, you did not 
accept them.

Reboot the workstation and follow the 
instructions for accepting the changes.

A Plug ‘n Play board might not 
automatically configure when 
added if the default 
configuration conflicts with 
other devices.

Use Windows 2000 or Windows XP Device 
Manager to deselect the automatic settings for 
the board and choose a basic configuration that 
does not cause a resource conflict. You can also 
use Computer Setup to reconfigure or disable 
devices to resolve the resource conflict.

Workstation will not start. Wrong memory modules were 
used in the upgrade or 
memory modules were 
installed in the wrong location.

1 Review the documentation that came with 
the system to determine if you are using the 
correct memory modules and to verify the 
proper installation.

2 Observe the beeps and LED lights on the 
front of the workstation. See the “POST and 
Error Messages” on page 148 to determine 
possible causes.

Power LED flashes Red five times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps five times.

Memory is installed incorrectly 
or is bad.

1 Reseat DIMMs.

2 Replace DIMMs one at a time to isolate the 
faulty module.

3 Replace third-party memory with HP 
memory.

4 Replace the system board.
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Power LED flashes Red six times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps six times.

Video card is not seated 
properly or is bad, or system 
board is bad.

For systems with a graphics card:

1 Reseat the graphics card. Power on the 
system.

2 Replace the graphics card.

3 Replace the system board.

4 For systems with integrated graphics, 
replace the system board.

Table 5-12 Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Table 5-13 Solving Network Problems

Problem Cause Solution

Wake-on-LAN feature is not 
functioning.

Wake-on-LAN is not enabled. Use the Network control application to enable 
Wake-on-LAN.

Network driver does not detect 
network controller.

Network controller is disabled. Run Computer Setup and enable network 
controller.

Incorrect network driver. Check the network controller documentation for 
the correct driver or obtain the latest driver from 
the manufacturer’s Web site.

Network status link light does not 
turn on or it never flashes.
NOTE: The network status light 
should flash when there is 
network activity.

No active network is detected. Check cabling and network equipment for 
proper connection.

Network controller is not set up 
properly.

Use the Network control application to verify 
that the device is working properly.

Network driver is not properly 
loaded.

Reinstall network drivers.

System cannot autosense the 
network.

Disable auto-sensing capabilities and force the 
system into the correct operating mode.

Diagnostics reports a failure. The cable is not securely 
connected.

Ensure that both ends of the data cable are 
securely connected. 

The cable is attached to the 
incorrect connector.

Ensure that the cable is attached to the correct 
connector.

There is a problem with the cable 
or a device at the other end of the 
cable.

Ensure that the cable and device at the other 
end are operating correctly.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, 
change the resource settings for the board.

The network controller 
is defective.

Replace the NIC.

Diagnostics passes, but the 
workstation does not 
communicate with the network.

Network drivers are not loaded, or 
driver parameters do not match 
current configuration.

1 Be sure the network drivers are loaded and 
that the driver parameters match the 
configuration of the network controller.

2 Be sure the correct network client and 
protocol is installed.

The network controller is not 
configured for this workstation.

Select the Network icon in the Control Panel 
and configure the network controller.
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Network controller stopped 
working when an expansion 
board was added to the 
workstation.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, 
change the resource settings for the board.

The network controller requires 
drivers.

Verify that the drivers were not accidentally 
deleted when the drivers for a new expansion 
board were installed.

The expansion board installed is a 
network card (NIC) and conflicts 
with the embedded NIC.

Under the Computer Setup Advanced menu, 
change the resource settings for the board.

Network controller stops working 
without apparent cause.

The files containing the network 
drivers are corrupted.

Reinstall the network drivers, using the Restore 
Plus! CD.

The cable is not securely 
connected.

Ensure that both ends of the cable are securely 
attached to the correct devices.

The network controller is 
defective.

Replace the NIC.

New network card will not boot. New network card might be 
defective or might not meet 
industry-standard specifications.

Install a working, industry-standard NIC, or 
change the boot sequence to boot from another 
source.

Cannot connect to network 
server when attempting Remote 
System Installation.

The network controller is not 
configured properly.

Verify Network Connectivity, that a DHCP 
Server is present, and that the Remote System 
Installation Server contains the NIC drivers for 
your NIC.

System setup utility reports 
unprogrammed EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Table 5-13 Solving Network Problems (Continued)

Problem Cause Solution
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Solving Memory Problems

CAUTION For those systems that support ECC memory, HP does not support mixing ECC and non-
ECC memory. Otherwise, the system will not boot the operating system.

Table 5-14 Solving Memory Problems

Problem Cause Solution

System will not boot or does not 
function properly after installing 
additional memory modules.

Memory module is not the 
correct type or speed or the 
new memory module is not 
seated properly.

Replace module with the correct industry-
standard device for the workstation.

On some models, ECC and non-ECC memory 
modules cannot be mixed.

Out of memory error. Memory configuration might 
not be set up correctly.

Use the Device Manager to check memory 
configuration.

You have run out of memory to 
run the application.

Check the application documentation to 
determine the memory requirements.

Memory count during POST is 
wrong.

The memory modules might 
not be installed correctly.

Check that the memory modules have been 
installed correctly and that proper modules are 
used.

Insufficient memory error during 
operation.

Too many Terminate and Stay 
Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of memory 
for the application.

Check the memory requirements for the 
application or add more memory to the 
workstation.

Power LED flashes Red five times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps five times.

Memory is installed incorrectly 
or is bad.

1 Reseat DIMMs.

2 Replace DIMMs one at a time to isolate the 
faulty module.

3 Replace third-party memory with HP 
memory.

4 Replace the system board.
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Solving Processor Problems
.

Solving CD-ROM and DVD Problems

Table 5-15 Solving Processor Problems

Problem Cause Solution

Poor performance is experienced. Processor is hot. 1 Be sure the airflow to the workstation is not 
blocked.

2 Be sure the fans are connected and working 
properly (some fans only operate when 
needed).

3 Be sure the processor heatsink is installed 
properly.

Power LED is Red and stays on. Processor is not seated 
properly or not installed.

1 Check to see that the processor is present.

2 Reseat the processor.

Table 5-16 Solving CD-ROM and DVD Problems

Problem Cause Solution

System will not boot from CD-ROM 
or DVD drive.

The CD-ROM or DVD boot is 
not enabled through the 
Computer Setup utility.

Run the Computer Setup utility and enable 
booting to removable media and verify boot 
order settings.

Non-bootable CD in drive. Try a bootable CD in the drive.

CD-ROM or DVD devices are not 
detected or driver is not loaded.

Drive is not connected properly 
or not properly configured.

1 Reconnect power and data cables to the 
drive.

2 Install correct device driver.

Movie will not play in the DVD 
drive.

Movie might be regionalized 
for a different country.

Refer to the documentation that came with the 
DVD drive.

Decoder software is not 
installed.

Install decoder software.

Cannot eject compact disc (tray-
load unit).

Disc not properly seated in the 
drive.

1 Turn off the workstation and insert a thin 
metal rod into the emergency eject hole and 
push firmly.

2 Slowly pull the tray out from the drive until 
the tray is fully extended, then remove 
the disc.
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CD-ROM, CD-RW, DVD-ROM, or 
DVD-R/RW drive cannot read a 
disc or takes too long to start.

CD has been inserted upside 
down.

Re-insert the CD with the label facing up.

The DVD-ROM drive takes 
longer to start because it has 
to determine the type of media 
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM 
drive determine the type of media being played. 
If the disc still does not start, read the other 
solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit.

Windows does not detect the 
CD-ROM or DVD-ROM drive.

1 Use Device Manager to remove or uninstall 
the device in question.

2 Restart the workstation and let Windows 
detect the device.

Recording audio CDs is difficult or 
impossible.

Wrong or poor quality media 
type.

1 Try using a slower recording speed.

2 Verify that you are using the correct media 
for the drive.

3 Try a different brand of media. Quality varies 
widely between manufacturers.

Table 5-16 Solving CD-ROM and DVD Problems (Continued)

Problem Cause Solution
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Solving Internet Access Problems

Table 5-17 Solving Internet Access Problems

Problem Cause Solution

Unable to connect to the Internet. Internet Service Provider (ISP) 
account is not set up properly.

Verify Internet settings or contact the ISP for 
assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections 
are correct using the quick setup documentation.

Web browser is not set up 
properly.

Verify that the Web browser is installed and set 
up to work with your ISP.

Cable/DSL modem is not 
plugged in.

Plug in cable/DSL modem. You should see a 
“power” LED light on the front of the cable/DSL 
modem.

Cable/DSL service is not 
available or has been 
interrupted due to bad 
weather.

Try connecting to the Internet at a later time or 
contact your ISP. (If the cable/DSL service is 
connected, the “cable” LED light on the front of 
the cable/DSL modem will be on.)

The LAN cable is not 
connected.

Connect the CAT5 10/100/1000 cable between 
the cable modem and the workstations’s RJ-45 
connector. (If the connection is good, the “PC” 
LED light on the front of the cable/DSL modem 
will be on.)

IP address is not configured 
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted. Windows 2000:

1 Select Start>Settings>Control Panel.

2 Double-click Internet Options.

3 On the General tab, click the Delete Cookies 
button.

Windows XP: 

1 Select Start>Control Panel.

2 Double-click Internet Options.

3 On the General tab, click the Delete Cookies 
button.

Cannot automatically launch 
Internet programs.

You must log on to the ISP 
before some programs will 
start.

Log on to the ISP and launch the desired 
program.
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Internet takes too long to download 
Web sites.

Modem is not set up properly. Verify that the correct modem speed and COM 
port are selected.
For Windows 2000:

1 Select Start>Settings>Control Panel. 
Continue with step #2.

For Windows XP:

1 Select Start>Control Panel. Continue with 
step #2.

2 Double-click System.

3 Click the Hardware tab.

4 In the Device Manager area, click the Device 
Manager button.

5 Double-click Ports (COM and LPT).

6 Right-click the COM port your modem uses, 
then click Properties.

7 Under Device status, verify that the modem 
is working properly.

8 Under Device usage, verify the modem is 
enabled.

9 If there are further problems, click the 
Troubleshoot button and follow the on-
screen instructions.

Table 5-17 Solving Internet Access Problems (Continued)

Problem Cause Solution
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POST and Error Messages
POST is a series of diagnostic tests that runs automatically when the system is turned on. An audible 
and visual message occurs if the POST encounters a problem. POST checks the following items to 
ensure that the workstation system is functioning properly:

Keyboard

Memory modules

Diskette drives

All SATA, IDE and SCSI mass storage devices 

Processors

Controllers

NOTE If the Power-On Password is set, a key icon appears on the screen while POST is running. You 
must enter the password before continuing.

Table 5-18 POST Error Messages

Screen Message Probable Cause Recommended Action

101–Option ROM Error System ROM checksum. Verify the correct ROM.

1 Flash the ROM, if needed.

2 If an expansion card was recently added, remove it 
and see if the problem remains. 

3 Clear CMOS.

4 If the message disappears, there might be a problem 
with the expansion card.

5 Replace the system board.

102–System Board Failure DMA, timers, and so on. 1 Remove expansion boards.

2 Replace the system board.

110–Out of Memory for Option 
ROMs

Option ROM for a device was unable 
to run due to memory constraints.

Run Computer Setup and enable the ACPO/USB Buffers 
at Top of Memory under the Advanced>Power-On 
option.

162–System Options Not Set Configuration incorrect. RTC (real-time 
clock) battery might need to be 
replaced.

1 Run Computer Setup (F10 Setup).

2 Set the date and time under Control Panel or in F10 
Setup depending on the operating system.

3 If the problem persists, replace the RTC battery.

163–Time and Date Not Set Invalid time or date in configuration 
memory.
RTC (real-time clock) battery might 
need to be replaced.

1 Set the date and time under Control Panel or in F10 
Setup depending on the operating system.

2 If the problem persists, replace the RTC battery.
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164–Memory Size Error Memory configuration is incorrect. 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Be sure memory modules (if any) are installed 
properly.

3 If third-party memory has been added, test using HP 
only memory.

4 Verify proper memory module type.

201–Memory Error RAM failure. 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Ensure memory and continuity modules are installed 
correctly.

3 Verify proper memory module type.

4 Remove and replace memory modules one at a time 
to isolate faulty module.

5 Replace the faulty memory modules.

6 If error persists after replacing memory modules, 
replace the system board.

207–ECC Corrected Single Bit 
Errors in Memory Sockets y,y

Single Bit ECC error. 1 Verify proper memory module type.

2 Try another memory socket.

3 Replace memory module if problem persists.

213–Incompatible memory 
Module in memory Sockets 
X,X, X

A memory module in memory socket 
identified in the error message is 
missing critical SPD information, or is 
incompatible with the chipset.

1 Verify proper memory module type.

2 Try another memory socket.

3 Replace memory with a module conforming to the 
SPD standard.

214–DIMM Configuration 
Warning

DIMMs not installed correctly (not 
paired correctly).

See “Memory” on page 93 for the correct memory 
configurations and reseat the DIMMs accordingly.

301–Keyboard Error Keyboard failure. 1 Reconnect keyboard with workstation turned off.

2 Check connector for bent or missing pins.

3 Ensure that none of the keys are depressed.

4 Replace keyboard.

303–Keyboard Controller Error I/O board keyboard controller. 1 Reconnect keyboard with workstation turned off.

2 Replace the system board.

304–Keyboard or System Unit 
Error

Keyboard failure. 1 Reconnect the keyboard with workstation turned off.

2 Ensure that none of the keys are depressed.

3 Replace keyboard.

4 Replace system board. 

402–Parallel Port 2 Address 
Assignment Conflict

IRQ address conflicts with another 
device.

Reset the IRQ.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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501–Display Adapter Failure Graphics display controller. 1 Reseat the graphics card (if applicable).

2 Clear CMOS.

3 Verify that the monitor is attached and turned on.

4 Replace the graphics controller.

510–Splash Screen image 
corrupted

Splash Screen image has errors. Install latest version of ROMPaq to restore image.

511–CPU, CPUA, or CPUB 
Fan not detected

Fan is not connected or might have 
malfunctioned.

1 Reseat fan cable.

2 Reseat the fan.

3 Replace the fan.

512–Chassis, rear chassis, or 
front chassis fan not detected

Fan is not connected, might have 
malfunctioned.

1 Reseat chassis, rear chassis, or front chassis fan 
cable.

2 Reseat chassis, rear chassis, or front chassis fan.

3 Replace chassis, rear chassis, or front chassis fan.

515–Power Supply fan not 
detected

Power Supply fan not seated properly. Reseat the power supply connector.

601–Diskette Controller Error Diskette controller circuitry or diskette 
drive circuitry incorrect.

1 Run Computer Setup (F10 Setup).

2 Check and/or replace cables.

3 Clear CMOS.

4 Replace diskette drive.

5 Replace the system board.

605–Diskette Drive Type Error Mismatch in drive type. 1 Run Computer Setup (F10 Setup).

2 Disconnect any other diskette controller devices (tape 
drives).

3 Clear CMOS.

918–Front USB Not 
Connected

Front USB is not connected. Connect front USB cable.

920–Fan Command 4 Pin 
Connector from Power Supply 
Not Connected

The 4-pin fan connector from the 
power supply is not connected.

Connect 4-pin fan connector.

921–Device in PCI Express 
Slot failed to initialize

PCI Express cards not seated 
properly.

Reseat all PCI Express cards in their PCI Express slots. If 
the problem persists, contact the PCI Express card 
vendor.

1720–SMART Hard Drive 
Detect Imminent Failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will 
fix an erroneous error message.)

1 Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
applicable.

2 Apply firmware patch if applicable (visit http://
www.hp.com/support).

3 Back up contents and replace hard drive.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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1721–SMART SCSI Hard 
Drive detects imminent failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will 
fix an erroneous error message.)

1 Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
applicable.

2 Apply firmware patch if applicable (visit http://
www.hp.com/support).

1785–MultiBay incorrectly 
installed

No other IDE device may be attached 
to the same IDE controller.

Attach the MultiBay as device 0 on the primary IDE 
controller.

1794–Inaccessible devices 
attached to SATA 1 and/or 
SATA 3

Devices attached to the primary IDE 
controller are inaccessible while the 
SATA controller is set to “Replace 
Primary IDE Controller in Setup.

1 Run Computer Setup (F10 Setup).

2 Select Storage>Storage Options and set SATA 
controller to Add as Separate Controller.

1796–SATA Cabling Error SATA cables are plugged into the 
incorrect connectors.

Follow the on-screen directions that are displayed in 
conjunction with this message. It will direct you to use the 
four SATA connectors in a particular sequence. The SATA 
connectors are color-coded dark blue, white, orange, and 
light blue.

1801–Microcode Patch Error Processor not supported by ROM 
BIOS.

Upgrade BIOS to proper version.

1998–Master Boot Record has 
been lost

The previously saved copy of the MBR 
has been corrupted.

Run Computer Setup and save the MBR of the current 
bootable disk.

1998–Master Boot Record has 
been changed

The current MBR does not match the 
previously saved copy of the MBR.

Use extreme caution, the MBR might have been updated 
due to normal disk maintenance activities (disk manager, 
fdisk, or format). Replacing the previously saved MBR in 
such situations can cause data loss. If certain that the 
MBR change is unintentional and undesired (for example, 
due to a virus), run Computer Setup and restore the 
previously saved MBR copy. Otherwise, run Computer 
Setup and either disable MBR security or save the MBR 
of the current bootable disk.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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